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Chapter -1 

Evolution of Computers 
I. Tick ( √ )the correct answer: 

1. (a) 

2. (b) 

3. (a) 

4. (b) 

5. (c) 

II. Fill in the blanks: 

1. Charles Babbage 

2. Second 

3. Integrated Circuits (Ics) 

4. Supercomputers 

5. Microcomputers 

III. Write T for true and F for false statements: 

1. False 

2. False 

3. True 

4. False 

5. True 

IV. Answer the following questions: 

1. An Abacus was the first calculating device. Abacus was used to perform simple calculations 

such as addition, subtraction, division and multiplication. Napier's Bones was mainly used for 

multiplication. Pascaline calculator used for accounting purposes. Difference Engine was the 

first automatic calculator. Analytical engine can compute complex mathematical calculations. 

2. There are five generations of computers namely First, second, third, fourth and fifth. First 

generation computers were very large in size. They used vacuum tubes and were extremely 

costly. Second generation computers were small in size, used transistors and were faster and 

cheaper. Third generation computers 

used ICs, had keyboard for input and monitor do display. Fourth generation computers operate 

on Microprocessors and VLSI circuits. Fifth generation computers will use artificial intelligence 

is still under research and development. 

3. Artificial intelligence means any device that will be able to think like human beings and take 

decisions like them. They will be intelligent like human beings 

4. Desktop computers, Laptop or notebook computers, tablet computers, handheld computers, 

minicomputers, mainframe computer, super computers. 

5. Advantages - It performs complex calculations quickly. It gives accurate result. It is useful for 

a wide range of activities. It can perform different tasks at the same time.  

Disadvantages - It operates only on a set of instructions. It has to be given instructions for every 

step to be performed. It cannot take 

decisions by itself and must have an user input. 

 



V. Match the following: 

1. (c) 

2. (e) 

3. (d) 

4. (a) 

5. (b) 

VI. Write the full forms of: 

1. ENIAC - Electronic Numerical Integrator and calculator. 

2. EDSAC - Electronic Delay Storage Automatic Calculator. 

3. EDVAC - Electronic Discrete Variable Automatic Computer. 

4. UNIVAC - Universal Automatic Computer. 

5. IC - Integrated circuit. 

6. PDA - Personal Digital Assistant. 

Chapter – 2 

Computer Software 
I. Tick ( √ )the correct answer: 

1. (c) 

2. (b) 

3. (a) 

4. (b) 

5. (a) 

II. Fill in the blanks: 

1. System software 

2. Application software 

3. General purpose application 

4. Software 

5. Hardware 

III. Distinguish between the following pairs: 

1. System software includes the operating system, language processors and utility programs 

which enables a 

computer system to operate. Whereas Application software is designed to perform a particular 

task. 

2. Computer hardware consists of the physical components that make up the computer system. 

Monitor, CPU, Keyboard, Mouse etc. are the components of hardware. Software is a computer 

program which is written to carry out a particular task on the computer. 

3. General purpose software is designed to satisfy common needs of a person or an organization. 

Tailor-made application software is created to satisfy specific needs of a person or an 

organization. 

IV. Classify the following as hardware or software: 

1. Hardware 

2. Hardware 

3. Hardware 

4. Software 

5. Hardware 

6. Software 

 



V. Answer the following questions: 

1. The basic software present in a computer is the operating system or OS. OS enables user to 

work with the hardware. It communicates with the hardware and monitors other programs. 

2. Windows, Mac OS X and Linux are some of the popular operating system. 

3. Example of hardware – Monitor Example of software – Logo. 

4. It performs tasks related to the management of computer functions like disk repair and data 

backup. 

5. Software can be classified as system software and application software. System software can 

be further classified as - 

i) Operating system - e.g. Windows, Linux 

ii) Language processor - e.g. - Java, C++ 

iii) Utility program - e.g. - Win Zip 

Application software is of two types - 

i) General purpose - e.g. MS Paint 

ii) Tailor - made - e.g. Railway reservation software 

 

Chapter – 3 

Advanced Formatting Features in MS-Word 
I. Tick ( √ )the correct answer: 

1. (b) 

2. (d) 

3. (d) 

4. (d) 

5. (a) 

 

II. Fill in the blanks: 

1. Paragraph spacing 

2. Indents 

3. Counterfeiting 

4. A page border 

5. Columns 

III. Write T for true and F for false statements: 

1. True 

2. False 

3. False 

4. True 

5. True 

IV. Answer the following questions: 

1. There are two types of spacing. 

i) Line spacing 

ii) Paragraph spacing 

The space between two adjacent lines of a paragraph is known as the line spacing. The vertical 

space before and after a paragraph is known as the paragraph spacing. 

2. Indents are used in paragraph to set the starting or ending points of the line on the page. 

Indents are of 4 types - 

i) Left Indent 



ii) Right Indent 

iii) Hanging Indent 

iv) First Line Indent 

3. Page orientation may be defined as a way of setting how the document will be printed. These 

are of two types - 

i) Portrait 

ii) Landscape 

4. A column break can be inserted if you want a particular text to be placed at the beginning of a 

column. Anything that is entered after a column break, it is shown at the beginning of a new 

adjacent column. 

5. Any text or image placed at the top of a page is known as a header. Footer is an image of text 

placed at the bottom of a page. These can be in texts, images, symbols, dates, page numbers. etc. 

6. A watermark can be defined as a light imprint behind the text, on every page of a MS-Word 

document. 

V. Match the following: 

1. (b) 

2. (d) 

3. (a) 

4. (e) 

5. (c) 

VI. Write the procedures for the following: 

1. Click on the page layout tab. On clicking the margins option a drop-down list appears. Choose 

the suitable margins option and click on it. 

2. Open customize watermark dialog box and click on picture watermark. On clicking on to 

select the picture watermark option, the selected picture will be set as watermark. 

3. Click on page border, we will find border and shading dialog box. Click on page border tab to 

choose the style, colour and width of the border. To choose an artistic border click on Art drop 

down menu. 

4. On clicking design the tab followed by page colour a list of several shades and colours will 

appear Select the colour and shade of your choice. The selected colour will be applied on the 

page. 

5. Click on the File tab and click on print and then print option. You can choose number of 

copies to be printed, choose the printed destination. 

 

Chapter – 4 

MS-Word 2013 : Insert Tab 
I. Tick the correct answer: 

1. (c) 

2. (b) 

3. (c) 

4. (d) 

5. (d) 

II. Fill in the Blanks: 

 1. Clipart 

2. Word-Art 

3. Remove 



4. Boring 

 

III. Write T for true and F for false statements: 

 1. T 

 2. T  

 3. F 

 4. T  

 5. T 

IV. Answer the following questions: 

 1. A Clip Art is a graphic or a picture which can be added to the document. In other images it is 

possible to resize, crop or add styles to a picture. 

2. There are following ways to edit the pictures in MSWord: 

Stretching and Resizing, Cropping, Adding Styles 

3. WordArt feature is used to add special and attractive effects to the text in a Word file. 

We can fill colour, change outline, add text effects, etc. to make it look more pleasing. 

4. To add shapes click on the insert tab. Now click on the shapes drop-down arrow to open a list 

of shapes. Choose any shape. Click on the word file and drag the shape without releasing the 

button. Release the mouse pointer when the desired shape is attained and then move it anywhere 

in the Word file. 

5. Click on the symbols drop-down arrow and a list of symbols will open. From a symbol dialog 

box choose any symbol and click on insert button. 

V. Match the following: 
 1. (c) 

2. (e) 

3. (a) 

4. (b) 

5. (d) 

VI. Name the tools: 

1. WordArt 

2. Crop 

3. Shapes 

4. Smart Art 

5. Pictures 

 

Chapter 5. 

Tables in MS Word 
I. Tick(√) the correct answer:  

1. (c) 

2. (c) 

3. (d) 

4. (c) 

5. (b) 

II. Fill in the blanks: 

 1. Table 

2. Column, row 

3. Alt + End 



4. Alt + Page Up 

5. Vertical, Rows 

 

 

III. Write T for true and F for false statement: 

 1. False 

2. True 

3. False 

4. True 

5. False 

IV. Answer the following Questions: 

1. It is simpler to read and understand. 

2. We need to click on the Insert tab, click on tables icon, drag the pointer to select the number of 

rows and columns we need, click and the table will be inserted. 

3. Entering data, selecting cells, rows, columns, selecting single cell, selecting range of cells, 

selecting entire row, selecting entire column, deleting rows and columns, add borders, change 

colours, etc. 

4. Merging of cells means to combine two or more cells into one cell. Select the cells in the row 

or column, click on the layout tab and then click on the merge cells option. 

5. Splitting cell is dividing a cell into several cells in the same row or column. Select the cell you 

want to split, click on the layout tab, click on the split cell option, a dialog box will appear asking 

for the number of columns and rows to be created, the data in the former cell will appear in the 

first cell after splitting. 

V. Match the following: 

1. (c) 

2. (a) 

3. (e) 

4. (b) 

5. (d) 

VI. Write the keyboard commands for the following: 

1. Right arrow or Tab 

2. Down arrow 

3. Left arrow or Shift+Tab 

4. Column Up arrow 

5. Alt+Page Up 

6. Alt+Page Down 

7. Alt+Home 

8. Alt+End 

Chapter 6 

MS PowerPoint 2013 
 I. Tick(√) the correct answer:  

1. (c) 

2. (b) 

3. (a) 

4. (a) 

5. (b) 



II. Fill in the blanks: 

1. slides 

2. theme 

3. presentation 

4. Slide sorter 

5. Note page 

III. Write T for true and F for false statement: 

 1. False 

2. True 

3. False 

4. False 

5. False 

IV. Answer the following Questions: 

 1. It is a single page in the presentation. 

2. A theme is a predefined combination of colours, fonts and effects that can be applied to a 

presentation. 

3. A ready to use predefined design of a presentation is called a template. 

4. Normal view, Slide sorter view, Note page view, Reading view. 

5. Slide layout is the arrangement of all items in the slide, such as pictures, text, music or videos. 

V. Match the following: 

1. (e) 

2. (d) 

3. (a) 

4. (c) 

5. (b) 

VI. Name the tools given below: 

1. Office theme 

2. From Beginning 

3. Normal 

4. Reading View 

5. Slide sorter 

Chapter 7 

Formatting Presentations 
I. Tick(√) the correct answer: 

1. (a) 

2. (d) 

3. (d) 

4. (a) 

5. (c) 

 II. Fill in the blanks: 
1. Slide master 

2. Horizontal 

3. Vertical alignment 

4. bullets 

5. negative 

III. Write T for true and F for false statement: 



1. False 

2. False 

3. True 

4. True 

5. True 

IV. Answer the following Questions: 
1. All the information on fonts, colours, backgrounds, effects, positioning, place holders sizes 

and so on are stored in the place called Slide Master in MSPowerPoint. We can make changes in 

the entire presentation or the parts with the same theme by making a change in the Slide Master. 

These changes get incorporated even if the slides have been added later on. 

2. The other fill effects available in PowerPoint are Gradient Fill, Picture or Texture Fill and 

Pattern Fill. In order to apply the Gradient fill, Click on Design Tab → Format 

Background option → Format Background Dialog box. In order to apply a Picture or Texture fill 

effect in the slide, you need to open the Format Background dialog box and follow the steps. 

3. The several formatting effects available for text in 

Power Point are- Font, Font size, Increase font size, 

Bold, Italic, Underline, Text shadow, Strikethrough, Character spacing, Change case, Font color. 

4. The alignment means the positioning of the text inside a text box. There are two types of 

alignments 

in MS-PowerPoint- Vertical Alignment and Horizontal Alignment. 

5. If the degree of rotation is positive, the rotation will be to the right and if the degree is 

negative, then the rotation will be to the left. 

6. In order to make a list, bullets are added in the beginning. Bulleted or numbered list organizes 

the items in a regular manner. In case we wish to add numbering to the list chosen, follow the 

steps given below- 

Click on the Home tab and Numbering will appear. 

 

V. Match the following: 

1. (c) 

2. (b) 

3. (a) 

4. (e) 

5. (d) 

VI. Name the tools given below:  

1. Slide master 

2. Insert placeholder 

3. Character spacing 

4. Change case 

5. Font color 

6. Bottom Align Text 

7. Justify 

8. Pictures 

9. Bullets 

10. Numbering 

 

 



 

 

 

 


